
1.0 Envisioning The Story (Brief Scope & Sequence for Storyboard - Not Included With Content) NOTES (Client/SME Roles)

Course Title Target Audience Context/Setting Please Write Below:

● Excelerate Your Excel Skills:
Microsoft Excel
Functionality Tips

● Are you ready to take your
Excel skills to the next level
and “excelerate” your
efficiency and productivity?

● The target audience of this course
is employees who need to improve
their proficiency in using
Microsoft Excel for inventory
management/data management in
order to increase their efficiency
and accuracy in data entry and
analysis.

● A narrator overviewing
Microsoft Excel
functionality tips through
the use of the platform.

Terminal Company
Overall Objective

Learning Objectives;
Performance Actions & Goals

Course Duration:

● By the end of Quarter 2,
accuracy, speed, and
efficiency in using advanced
functions in Microsoft Excel
will increase by 30% as
employees will implement
informed practices to
analyze, manage, and present
data to improve overall
productivity in the
workplace.

● Explain the purpose and function
of Microsoft Excel.

● Create and manage spreadsheets
that can be easily updated and
shared with colleagues.

● Enter and format data in cells,
rows, and columns.

● Apply strategies to automate tasks
- such as filtering, sorting, and
formatting data.

● Modify charts and graphs that
effectively communicate data
insights.

● 6 minutes

…



1.1 Hook - Question (Related To Topic) NOTES (Client/SME Roles)

Voice Over Script On-Screen Text Graphics Notes Please Write Below:

[1] NARRATION: Are you tired of
spending hours on Microsoft Excel
and feeling like you're not making
progress? Are you ready to take your
Excel skills to the next level and
excelerate your efficiency and
productivity? Look no further! In this
video, we’ll share some practical tips
to help you excelerate your Excel
skills.

[1] OST: Excelerate Your Excel
Skills: Microsoft Excel Functionality
Tips

*OST - On Screen Text

[1] IMAGE: Opening shot of a
frustrated person sitting at a desk with
a computer and an Excel spreadsheet
on the screen]

[2] IMAGE: Clock and person in
office or at computer looking
tired/frustrated at the clock

[3] IMAGE: Level up scene with
chart or graphic.

1.2 Review Learning Objectives NOTES (Client/SME Roles)

Voice Over Script On-Screen Text Graphics Notes Please Write Below:

[1] NARRATION: Our focus will be
on some of the key features and
functionalities in Excel that can help
you save time, automate tasks, and get
the most out of your data. You’ll be
able to explain the purpose and
function of Microsoft Excel and create
and manage spreadsheets that can be
easily updated and shared with your
colleagues. We’ll review entering and
formatting data into cells, rows, and
columns, and apply these strategies to
automate tasks - such as filtering,

[1] OST: Learning Objectives
Explain the purpose and function of
Microsoft Excel.
Create and manage spreadsheets that
can be easily updated and shared with
colleagues.

Enter and format data in cells, rows,
and columns.
Apply strategies to automate tasks -
such as filtering, sorting, and
formatting data.

[1] IMAGE: Learning Objectives
listed out



sorting, and formatting data. And, last
but not least, we’ll modify charts and
graphs that effectively communicate
data insights.

Modify charts and graphs that
effectively communicate data
insights.

*OST - On Screen Text

1.3 Define Microsoft Excel NOTES (Client/SME Roles)

Voice Over Script On-Screen Text Graphics Notes Please Write Below:

[1] NARRATION: Microsoft Excel is
a software spreadsheet tool program
designed for data analysis,
organization, and management to
efficiently store and manipulate large
sets of data. Microsoft Excel is
beneficial for your workplace because
it allows users to create spreadsheets,
charts, graphs, and other visual
representations of data to better
understand trends, patterns, and
relationships within the data.

[1] OST: Microsoft Excel Definition
A software spreadsheet tool program
from Microsoft  designed for data
analysis, organization, and
management to efficiently store,
analyze, and manipulate large sets of
data.

*OST - On Screen Text

[1] IMAGE: Definition on computer
screen/same one in the intro

[2] IMAGE: Introduce Microsoft
Excel as a superhero who comes to
the rescue of the learners' data woes

1.4 Begin Tutorial - Open Spreadsheet NOTES (Client/SME Roles)

Voice Over Script On-Screen Text Graphics Notes Please Write Below:

[1] NARRATOR: First, we’re going
to start by having our Microsoft Excel
application open. Go to Excel’s
homepage, and click on the “New+”
button, then “Blank Workbook”to
open the application.

[1] OST: Hover mouse/icon with
mouse

*OST - On Screen Text

[1] IMAGE: Screen fades in to show
a Microsoft Excel homepage - click
through to blank workbook.



1.5 Cell Explanation NOTES (Client/SME Roles)

Voice Over Script On-Screen Text Graphics Notes Please Write Below:

[1] NARRATION: Here we have a
spreadsheet - a blank slate waiting to
be filled with data. As we open this
file, you can see the rows, columns,
and cells. Let's take a closer look at
this cell right here. As you can see,
each cell in Excel is identified by a
unique cell reference that consists of
the column letter and the row number.
This cell, for example, is in column C
and row 5, so its cell reference is C5.”
A cell can contain different types of
data, such as numbers, text, dates,
formulas, and functions.

[1] OST: Hover mouse/icon with
mouse

[2] OST: Cell Definition
The basic unit - or building block - of
an Excel spreadsheet, and it is the
intersection point between a row and
a column.

*OST - On Screen Text

[1] IMAGE: Screen fades into blank
spreadsheet

[2] IMAGE: Click on a specific cell
in the spreadsheet and the view zooms
in on that cell

[3] IMAGE: Cell definition

1.6 Introducing Data Set NOTES (Client/SME Roles)

Voice Over Script On-Screen Text Graphics Notes Please Write Below:

[1] NARRATION: For today’s
purposes, our data set has already been
imported into Microsoft Excel.
Looking at our data set, located at the
top of our Excel sheet is our title - or
label. This spreadsheet analyzes the
amount of smart watches that have
been sold per state for Quarter 1,
Quarter 2, Quarter 3, and Quarter 4.
On the left-hand side of our screen,

[1] OST: Hover mouse/icon with
mouse

[1] IMAGE: A cursor highlights the
title on Excel spreadsheet.

[2] IMAGE: Cursor moves to
left-hand side of screen to data sets.



each state appears with four different
values. Each value represents how
many smartwatches were sold in each
quarter for that state. The data as it is
looks messy and disorganized.

1.7 Text To Columns NOTES (Client/SME Roles)

Voice Over Script On-Screen Text Graphics Notes Please Write Below:

[1] NARRATION:
In order to organize this data and
easily split the text into separate
columns, first, we will need to use the
toolbar located above our spreadsheet
title. The toolbar will be where all of
our functionality tools are located.
Select the cell or range of cells that
contain the text you want to split.
Next, click on the "Data" tab in the
ribbon at the top of the Excel window,
and then click on "Text to
Columns".In the "Convert Text to
Columns Wizard" window that
appears, select "Delimited" and click
"Next".In the next screen, select the
delimiter that separates the text you
want to split. This could be a comma,
a semicolon, a space, or any other
character. You can preview the results
in the Data Preview section. Select
“Space” since spaces separate each of
our data sets to indicate splitting into a
new column. Once you've selected the

[1] OST: Hover mouse/icon with
mouse

*OST - On Screen Text

[1] IMAGE: A cursor highlights a
range of cells in an Excel worksheet.

[2] IMAGE: The cursor moves to the
"Data" tab in the Excel ribbon.

[3] IMAGE:The "Data" tab in the
Excel ribbon is highlighted, and the
cursor moves to the "Text to
Columns" button.

[4] IMAGE: The "Convert Text to
Columns Wizard" window appears.

[5] IMAGE:The cursor clicks on the
"Delimited" option, and then clicks
"Next".

[6] IMAGE:The cursor highlights the
"Space" option as the delimiter for the
data set.

[7] IMAGE:The cursor clicks on
"Next" to continue.



delimiter, click "Next". You can then
select the format for each column,
such as "General", "Text", or "Date".
Select “General” there is nothing to
change about the data set’s format.
Click "Finish" and voila! Your text is
now split into separate columns based
on the delimiter you selected.

[8] IMAGE:The cursor highlights the
"General" option for the format of
each column.

[9] IMAGE:The cursor clicks on
"Finish" to complete the text to
columns process.

[10] IMAGE:The data set is split into
separate columns in the Excel
worksheet.

1.8 Conditional Formatting NOTES (Client/SME Roles)

Voice Over Script On-Screen Text Graphics Notes Please Write Below:

[1] NARRATION: We can also
visually highlight cells that meet
specific performance criteria. In order
to visually see which states are selling
the most smartwatches per quarter and
which states are selling the least
amount of product per quarter, select
the Quarter 1 data cell vertically.
Then, select the "Conditional
Formatting" button in the "Home" tab
of the Excel ribbon. In the drop-down
menu, select the type of formatting
you want to apply. For our example,
let's choose "Color Scales.” Choose
the formatting options that you want to
use. For example, we'll choose a
green-yellow-red color scale to

[1] OST: Hover mouse/icon with
mouse

[1] IMAGE: Opening shot of an
Excel spreadsheet with data in it

[2] IMAGE: Cursor hovers over
Quarter 1 data cells

[3] IMAGE: Screen displays the
Home tab with the Conditional
Formatting button highlighted

[4] IMAGE: Screen displays the
drop-down menu and highlights the
"Color Scales" option

[5] IMAGE: Screen displays the
Color Scales options with the selected
green-yellow-red scale highlighted



highlight cells with higher sales in
green, moderate sales in yellow, and
lower sales in red. Click "OK" to
apply the formatting to the selected
cells. Now, you can see that the cells
are color-coded based on their sales
value, making it easy to identify which
cells have higher or lower sales. Let’s
apply this to the rest of our quarterly
cells.

[6] IMAGE: Screen shows the
selected cells with the new
color-coded formatting applied

[7] IMAGE: Screen zooms out to
show the full data set and screen
displays the rest of the quarterly cells
with the same color-coded formatting
applied

1.9 Formula - SUM NOTES (Client/SME Roles)

Voice Over Script On-Screen Text Graphics Notes Please Write Below:

[1] NARRATION: Next, we’ll use
formulas to effectively analyze the
data from each of the quarters. We will
start with a formula that can add cells
together. First, go down to the bottom
of our Quarter 1 column. Once there,
click on the next available, colorless
cell. Then, type in the equal sign and
S-U-M (=SUM). You will follow this
with the first cell in the range you
want to add, a colon, and the last cell
in the range you want to add. So, in
this example, the first number in
Quarter 1 appears in the cell B3 - I
will type that first. Then, I will type a
colon. Anytime you use a  colon, in
Excel, it literally means the word
“through.” After you include a colon,

[1] OST: Hover mouse/icon with
mouse

[2] OST: Anytime you use a  colon,
in Excel, it literally means the word
“through.”

[1] IMAGE: Opening shot of an
Excel spreadsheet with data for each
of the quarters

[2] IMAGE: Camera zooms in to the
bottom of the Quarter 1 column

[3] IMAGE: As the narrator explains,
the text appears on the screen

[4] IMAGE: The narrator
demonstrates typing the formula as
the text appears on the screen

[5] IMAGE:The camera shows the
typed formula in the cell

[6] IMAGE: The camera shows the
highlighted total in blue



type the last cell you want to appear in
the range you’re adding. In this case,
we are adding all of Quarter 1, so the
last cell in this example is B52. So, the
final product should look like
(=SUMB3:B52). Once you've typed in
the formula, hit enter and the sum of
the values in the selected range will
appear in the cell. It's that simple! The
SUM function is a powerful tool for
quickly calculating totals in Excel."
Do this for the rest of the quarterly
cells. Then, highlight your sum blue to
denote that this is the total of your
cells.

[7] IMAGE: The camera shows the
process being repeated for the rest of
the quarterly cells, with the totals
highlighted in blue

Closing shot of the Excel spreadsheet
with highlighted totals for each of the
quarters

1.10 Formula - AVERAGE NOTES (Client/SME Roles)

Voice Over Script On-Screen Text Graphics Notes Please Write Below:

[1] NARRATION:
We’ll now calculate the averages of
each of our quarterly cells. It has a
very similar process to our SUM
formula used previously. Again, go
down to the bottom of our Quarter 1
column - below our SUM cells that
now appear. Once there, click on the
next available, colorless cell. Then,
type in the equal sign and AVERAGE
(=AVERAGE). You will follow this

[1] OST: Hover mouse/icon with
mouse

[1] IMAGE: Opening shot of an
Excel spreadsheet with data for each
of the quarters

[2] IMAGE: Cursor highlights the
cell below the SUM cells in Quarter 1.

[3] IMAGE: Viewer typing in the
AVERAGE formula, starting with an
equal sign and followed by the
AVERAGE function.



with the first cell in the range you
want to add, a colon, and the last cell
in the range you want to add -
identical to the SUM formula.
Remember - last time our cell range
was B3 to B52. Type this in and use a
colon to separate the cells. End the
formula with another parenthesis and
press enter. The average amount of
smartwatches sold quarter 1 per state
is now available to you! Again, do this
for the rest of the quarterly cells.
Then, highlight your averages purple
to denote that this is the average for
each of your cells.

You can also use the AutoSum and
Auto Average button located at the
Home Screen - but sometimes the
totals can be off.

[4] IMAGE: Highlights the range of
cells the viewer wants to add,
separated by a colon.

[5] IMAGE: Highlights the cells in
the selected range and shows the
viewer pressing the Enter key.

[6] IMAGE: Shows the viewer
repeating the same process for the rest
of the quarterly cells.

[7] IMAGE: Highlights the cells with
the calculated averages in each quarter
and highlights the cells with purple to
denote the average for each of the
cells.

[8] IMAGE: Show AutoSum and
AutoAverage on Home Screen

1.11 U.S. Inventory Map NOTES (Client/SME Roles)

Voice Over Script On-Screen Text Graphics Notes Please Write Below:

[1] NARRATION: Finally, we can
use the Filled Map feature in Excel to
create a “heat map” of the United
States to indicate, through color,
which states are selling more product
overall versus other states for each of
our quarters. First start by selecting
the States and Quarter 1 column.

[1] OST: Hover mouse/icon with
mouse

[1] IMAGE: Shows the Excel
interface with the States and Quarter 1
column selected

[2] IMAGE: Shows the copy-paste
command being executed



Then, copy the selected column. Once
you have copied the selected column,
go to the Insert tab. Then, locate the
Filled Maps button. Click on “Filled
Maps” Once clicked, a map of the
United States should appear and
color-colored. The darker color states
indicate that more products are being
sold. The lighter color states indicate
that less product is being sold. You can
make a heat map for each of your
quarterly data sets in under seconds!

[3] IMAGE: Highlights the Filled
Maps button being clicked and a map
of the United States appearing

[4] IMAGE: Highlights the heat map
for Quarter 1

1.12 Wrap Up NOTES (Client/SME Roles)

Voice Over Script On-Screen Text Graphics Notes Please Write Below:

[1] NARRATION: By implementing
the tips and strategies you've learned
in Microsoft Excel, you can streamline
your workflow, save time, and
communicate data insights effectively.
Remember, the key to mastering Excel
is consistent practice and
experimentation. Don't be afraid to try
new functions and features to see what
works best for you. Keep
“excelerating,” and happy
spreadsheet-ing!

[1] OST: Hover mouse/icon with
mouse

[1] IMAGE: Opening shot of a
frustrated person sitting at a desk with
a computer and an Excel spreadsheet
on the screen]

[2] IMAGE: Clock and person in
office or at computer looking
tired/frustrated at the clock

[3] IMAGE: Level up scene with
chart or graphic.


